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Introduction to ZipShell Pro

        ZipShell Pro is a program for the Microsoft Windows environment which allows the user to easily
access the power of data compression technology without spending the large amounts of time 
required to become proficient in the use of various compression/decompression programs (i.e., 
archivers).    Its internal archiving routines enable many operations (zipping, unzipping, and unarjing) 
to be carried out within Windows, saving the user both the time and inconvenience of shelling to 
DOS to use another program.

          This program acts as a command center for creating, modifying and extracting archives in 4 
major formats:    ARC, ARJ, LZH, and ZIP.    Using ZipShell Pro, you may treat these different 
archives in the same way; ZipShell Pro takes care of their differences automatically.    There is no 
need to learn a different command set for each type of archive.

          ZipShell Pro allows the user to perform more complex tasks, such as archive comment 
manipulation, password encryption, and self-extracting archive creation, with a few keystrokes or 
mouse-clicks.    Simple tasks, such as compressing or extracting files, often require as few as 1 or 2 
keystrokes or mouse-clicks.

          NewVision is constantly updating ZipShell Pro to reflect new archiver versions and is continually
being fine-tuned in terms of speed and performance, making it a powerful tool for archive 
management.

          ZipShell Pro is not a free program; rather, it is Shareware. After evaluating ZipShell Pro for 30 
days, you are obligated to either register it or discontinue using it.

See Also:
Installation Instructions
De-Installation
Registering ZipShell Pro
System Requirements



Installation Instructions

To install ZipShell Pro, execute the Windows self-extracting archive that ZipShell Pro is distributed in.
This is a compressed format; thus the files may not be installed manually.    When asked to enter the 
"Extraction Path", enter a suitable directory on your hard drive.    If the specified directory does not 
exist, it will be created, and all the ZipShell Pro files will be copied there.

After all the required files are copied to your hard drive, you will be asked to enter your registration 
information.    If you are evaluating a shareware version of ZipShell Pro, just press the "Skip" button.  
If you are installing a registered version, enter your name, company and serial number in the spaces 
provided.    The serial number is located on the disk label of the ZipShell Pro disk.

ZipShell Pro is an "ini-friendly" program and does not write information to either the WIN.INI or 
SYSTEM.INI files, but rather creates its own ZIPSHELL.INI file.

By default, ZipShell Pro supports the use of PKZIP/PKUNZIP version 2.04x.    If you are using 
PKZIP/PKUNZIP version 1.10, it is ESSENTIAL you follow these instructions:    Select the Options 
command from ZipShell Pro's Setup menu, then press F5 (or click on the Archivers picture) to go to 
the archivers section.    Then, select the option button labelled "1.10" next in the PKZIP & PKUNZIP 
section at the upper-right part of the screen.    Press the OK button, and this information will be saved
to disk, and ZipShell Pro will work properly with the software you have.



De-Installation

If you later decide you wish to uninstall ZipShell Pro, there are a number of files ZipShell Pro copies 
to your hard drive that reside in locations other than your ZipShell directory.    You may safely delete 
these files if you no longer wish to use ZipShell Pro.    The following files are located in your 
/windows directory:

· ZIP001.PIF
· ZIP002.PIF
· ARC002.PIF
· ARJ001.PIF
· LZH001.PIF
· ZIPSHELL.INI

In addition, the following shared files are installed to your /windows/system directory.    You may 
delete them only if you are sure they are not being used by other programs.

· VBRUN300.DLL
· THREED.VBX
· TOOLBUTN.VBX



Registering ZipShell Pro

ZipShell Pro is not free; rather, it is Shareware.    You are granted limited period of 30 days in which 
to use the program for evaluation purposes.    If you continue to use the program after the 30-day 
evaluation period has expired, you must register it.

When you register the program, NewVision will send you a diskette with the latest version of the 
program.    You will be provided your own unique serial number which you can use when installing 
the program so that the program does not show the "About" window on startup.    Also, you will be 
eligible for discounts on future versions of the program and will be notified of major upgrades.

Register By Mail
To view and/or print a registration form, select the "Order Form" command from ZipShell Pro's "Help"
menu.    Fill this form out, and mail it along with a check or money order to NewVision, and you will 
receive your registered copy of the lastest version of ZipShell Pro in 2 to 3 weeks.

CompuServe Members
If you have an account on CompuServe, you may register ZipShell Pro on CompuServe and have 
the registration fee charged to your CompuServe account.    To do so, type GO SWREG and register 
program with ID 1551.    After you do so, NewVision is notified of your order and will promptly ship 
you a registered copy of the latest version of ZipShell Pro.

World Intershare Network (WIN)
Users may optionally register through the World Intershare Network program, which is managed 
directly through their agents.    Registrants through WIN will not receive an additional copy of the 
program, as they already have a current registered version. WIN registrants are, however, eligible for
discounts on future versions and upgrades.



System Requirements

To run ZipShell Pro, your system must meet or exceed the following minimum requirements.

· 80286 or higher processor (80386 or higher needed for built-in compression and extraction)
· 2 Megs RAM
· Windows 3.1 or later
In addition, you must also have copies of any of the DOS-based archivers you wish ZipShell Pro to 
utilize, although ZipShell Pro can perform many functions without the presence of any other archiver.



Menu and Toolbar Commands

Below is a list of all the commands available from ZipShell Pro's menus.    Select a command to see 
a description of its function and purpose.

File Menu
New Archive
Open/New Window...
Open/Current Window...
Close Archive
Save Archive As...
Delete Archive...
Preferences...

Action Menu
Test Archive Integrity
Display Extended Info
Fix Corrupted ZIP Archive
Join ARJ Archives
Convert...
Make EXE...
Make WinSFX

Sort Menu
The Sort Menu allows you to sort the contents of the main display according to various criteria.    
When an archive is first opened, it is unsorted:    the files appear in the order in which they appear 
inside the archive.    You can choose to sort them by choosing one of the commands under the Sort 
Menu.

Window Menu
The Window Menu allows you to control the positions of the windows of ZipShell Pro's MDI Interface.
You can use the commands of this menu to arrange all displayed windows or to bring any open 
window to the top.    The "New Window" command is used to create a new, empty archive window in 
addition to any windows that are currently open.

Help Menu
Use the commands in the Help Menu to display various information about different aspects of 
ZipShell Pro.    The "Order Form" command will open up the file ZSORDER.TXT in Notepad, allowing
you to view and/or print the file.    The "About" command will display ZipShell Pro's About window, 
displaying various useful information, such as program version and free Windows memory and 
resources.

ZipShell Toolbar





File:    “New Archive” Command

Selecting this command from the "File" menu allows you to create a new archive in the current 
window.    Any archive currently open will be closed, and you will be prompted first for the name and 
location of the new archive, and then for files you wish to add to the archive.

See Also:
Creating a new archive



Creating a New Archive

To create a new archive, press the "New" button on ZipShell's main display.    The current archive (if 
any) will be closed, and you will be prompted for the name and location of the archive to be created.  
The extension you give the filename will determine the archive's format:    a filename ending in ".ZIP" 
will be treated as a ZIP archive, and so forth.

After this step has been completed, the "Add Files to Archive" window is displayed, which allows you
to specify which files you want to add to the new archive, as well as giving access to various 
compression options.    When you have finished with this window, press the "Add" button, and 
ZipShell will create your new archive and display its contents on the main display.

See Also:
“Add Files To Archive” Window
Complete List of Compression Options



“Add Files To Archive” Window

After pressing the "Add" button on ZipShell Pro's iconbar, the "Add Files To Archive" Window is 
displayed.    

You can navigate through the drives and directories on your hard drive looking for files you wish to 
add to an archive.    To select a file to add, either double-click on its filename in the list of files, or 
select the file and press the "Add File(s)" button.    The file or files you selected will appear in the list 
on the right, indicating that it will be added to the archive.

If you wish to add an entire directory to an archive, double-click on the directory name in the list of 
directories and press the "Add Directory" button.    The name of the directory will appear in the list on 
the right.

When you have selected all the files and directories you wish to add to the archive, you may do one 
of two things:    1) accept ZipShell Pro's default compression options and press the "Add" button to 
begin compression immediately, or 2) press the "Next >>" button to display ZipShell Pro's 
compression options.

See Also:
Complete List of Compression Options



Complete List of Compression Options

Below is a list of all the compression options available in ZipShell Pro.    Click on an option to see its 
description.    During compression, only those options which are applicable for the type of archive 
being used will be enabled.

 Span multiple floppies
 Include pathnames
 Use authenticity verification
 Keep a .BAK of ARJ archive
 Exclude pathnames
 Move files to archive
 Recurse subdirectories
 Scramble with password
 Add volume label
 Use working drive
 Compression amount
 ZIP format

See Also
“Add Files To Archive” Window



ZipShell Pro will use PKZIP.EXE to compress the archive onto multiple floppy diskettes.    During 
compression, the PKZIP.EXE window will be displayed at normal size so that you can see when 
PKZIP.EXE requests a new diskette.

Available only for new ZIP archives created on drive A: or B:.



As ZipShell Pro compresses files into an archive, it will store path information with the files.

Available for ZIP archives.



ZipShell Pro will use PKZIP.EXE to compress the archive using the authenticity verification (-!) 
switch.    This will help prevent tampering with the archive.    Only registered users of PKZIP.EXE 
have the ability to use this feature.

Available for ZIP archives.



If you are modifying an existing ARJ archive, a backup of the archive (with a .BAK extension) will be 
made before the archive is modified.

Available for ARJ archives.



During compression of an ARJ archive, ARJ.EXE will not include path information with the archive.    
If this option is left unchecked, ARJ.EXE by default will include path information inside the archive.

Available for ARJ archives.



After successful compression, the files that have been compressed into the archive will be deleted 
from their source directories.    If an error occurs during compression, no files will be deleted.

Available for all archive types.



Causes ZipShell Pro to include the subdirectories of all specified directories and add those to the 
archive as well.    In order for this option to be effective, you must specify at least one directory to add
to the archive, instead of simply specifying individual files.

Available for ZIP archives.



PKZIP.EXE or ARJ.EXE will compress the selected files and encrypt them with the specified 
password.    In order for these files to be successfully extracted at a later time, the same password 
must be supplied during the extraction process.    If you forget the password used to encrypt the 
archive, you will not be able to access any of the encrypted files.

Available for ARJ and ZIP archives.



PKZIP.EXE or ARJ.EXE will store inside the archive the volume label of the specified drive.    This 
volume label can later be extracted, causing the volume label of the target drive to be renamed.

Available for ARJ and ZIP archives.



During the compression process, all temp files will be written to the specified drive.    This option is 
especially useful for modifying archives on floppy diskettes, since often there will not be enough 
room on the floppy to store the necessary temporary files.

Available for ARJ and ZIP archives.



Specifies the amount of compression you want used when compressing the files.    The range is from
none (in which case the files will be stored instead of compressed) to maximum (which takes the 
most time but delivers the smallest archives).

Available for ARJ and ZIP 2.04 archives.



Specifies which ZIP format you want to use when compressing a ZIP archive.    It is suggested that 
you use 2.04, since that format delivers better compression ratios and is compatible with ZipShell 
Pro's built-in compression routines.    If you select 1.10, ZipShell Pro will use PKZIP.EXE v1.10 to 
compress the archive.

Available for ZIP archives.



File:    “Open/New Window” Command

Selecting this command from the "File" menu will allow you to open an archive in a new window in 
order to display its contents.      If you wish to open the archive in the current window instead, choose 
the "Open/Current Window" command.



File:    “Open/Current Window” Command

Selecting this command from the "File" menu will allow the user to open an archive in order to 
display its contents.    The archive will be opened up in the current window, replacing any archive that
is already there.    If you wish to open the archive in a new window instead, use the "Open/New 
Window" command.



File:    “Close Archive” Command

Selecting this command from the "File" menu closes the archive in the current window and returns 
the window to its initial state:    empty and untitled.    From this point, you may create a new archive 
by adding files to the empty archive or open and display another archive in this window.

It is not necessary to close an archive before opening another into the same window, or before 
quitting ZipShell Pro.

See Also:
Adding files to an archive
Creating a new archive
Opening and viewing an archive



Adding Files to an Archive

There are two ways to add files to an archive:    1) drag and drop, and 2) the "Add Files" window.    
Which way you choose to add files to an archive is mostly a matter of personal preference.

Drag and Drop
A simple way to add files to an archive is using drag and drop.    Simply open any file manager you 
like to use that supports drag and drop (such as the ones that come with Windows, Norton Desktop, 
or PC Tools), and select the files and/or directories you wish to add.    Then drag them and drop them
somewhere on ZipShell Pro's main window (or icon, if the program is minimized).    

At this point, if you have dropped the files onto an empty, untitled archive window, you will be asked 
for the name and location of the new archive.    Then, whether you are creating a new archive or 
adding files to an existing one, the "Add Files" window will be displayed (with the files that you 
dropped onto ZipShell Pro showing up in the "Files to be added" list) allowing you to select 
compression options or to continue the compression process.

The “Add Files to Archive” Window
Another way to select files to add to an archive is via the "Add Files" window.    From ZipShell Pro's 
main toolbar, press the "Add" button.    This will display the "Add Files" window.    If you are adding 
files to an empty, untitled archive, you will be asked for the name and location of the new archive at 
this point.

Next, you can use the drive, directory and file lists of the "Add Files" window to select files that you 
wish to add to the archive.    From there, you can choose to modify compression options or continue 
the compression process.

See Also:
“Add Files to Archive” Window
Complete List of Compression Options
Creating a New Archive



Opening and Viewing an Archive

Before performing any operation on an archive, such as extracting, converting, or adding files to it, it 
is necessary to open it and have its contents displayed.

You may either choose to open the archive in the current archive window, in which case it will 
replace the the archive already there, if any, or you may open the archive into a new window.      To 
open the archive in the current window, select the "Open/Current Window..." command from the 
"File" menu.    To open the archive in a new window, select the "Open/New Window..." command 
from the "File" menu.

After specifying the archive you wish to open, ZipShell Pro will scan the archive, determine its 
format, and display its contents on the screen.

Using Drag-and-Drop to Open an Archive

Another way to open an archive is to drag it from any file manager that supports drag and drop 
operations and drop it on the ZipShell Pro window (or icon, if the program is minimized).    As long as 
the archive has a .ZIP, .ARJ, .ARC, or .LZH extension, ZipShell Pro will open the archive and display
it in the current archive window.

If you specify more than one file, or the file you specify does not have an archive extension, ZipShell 
Pro assumes that you are trying to add the dropped files to the current archive.

See Also:
Adding Files to an Archive



File:    “Save Archive As” Command

Selecting this command from the "File" menu allows you to save the current archive to a different 
location, optionally giving the file a new name.    If the "Delete original archive after successful copy" 
box is checked, the archive will be moved; if this box is unchecked, the archive will be copied, and 
the original archive will be left intact.



File:    “Preferences” Command

Selecting this command causes ZipShell Pro to display its Options dialog, allowing you to select 
options for the following categories:    General Options, Display Options, Archivers, and Paths.



Action:    “Test Archive Integrity” Command

Selecting this command from the "Action" menu will cause ZipShell Pro to check the current archive 
for errors.    To do this, ZipShell Pro extracts the entire file to memory, checking for CRC errors and 
archive structural errors.    If the archive to be tested is large, this process may take a while.

Available for ARJ and ZIP archives.



Action:    “Display Extended Info” Command

Selecting this command from the "Action" menu causes ZipShell Pro to open a new window and 
display the contents of the archive, listing more information for each file than is available in ZipShell 
Pro's normal display.    In particular, the file's creation time, CRC, and path (if any) are displayed 
along with the other information.

Available for ARJ and ZIP archives.



Action:    “Fix Corrupted ZIP Archive” Command

Selecting this command from the "Action" menu will cause ZipShell Pro to launch the DOS program 
PKZIPFIX.EXE to attempt to reconstruct a corrupted ZIP archive.    PKZIPFIX.EXE is a program that 
comes with both versions of PKZIP and PKUNZIP.    If ZipShell Pro cannot find it, it will ask you for its
location.

PKZIPFIX attempts to recover as much information as possible from corrupted ZIP archives.    It will 
create a new archive, called PKFIXED.ZIP, containing as many files as were recovered.    When 
PKZIPFIX is finished, ZipShell Pro will open up the PKFIXED.ZIP archive for you to view.

PKZIPFIX cannot always completely recover archives that have been corrupted, and can do nothing 
about CRC errors.

Available for ZIP archives.



Action:    “Join ARJ Archives” Command

Selecting this command from the "Action" menu allows you to join two ARJ archives together to 
create a third one.    First you will be prompted for an archive to join the current ARJ archive with:    
this can be any ARJ archive other than the current one.    Second, you will be asked for a new 
filename for the resultant archive which will contain all the files of the first and second archives.    

Available for ARJ archives.



Action:    “Convert” Command

Selecting this command will bring up the "Convert Archive" window, allowing you to convert an 
archive between types (i.e. ZIP -> ARJ), between versions (i.e. ZIP 1.10 -> ZIP 2.04), or between 
formats (i.e. ZIP SFX -> Normal ZIP).

To convert the current archive, just select this command and then choose the destination format in 
the window provided.    All the rest is automatic.    When ZipShell Pro is finished converting the 
archive, the newly created archive will be opened and viewed.

Archives may be converted to ZIP 2.04, ZIP 1.10, ARJ or LZH formats.    Conversion to ARC format 
is not supported; however, you may convert an ARC archive to any of the other types.

Special operations are possible when the source and destination type are the same.    For example, 
you could "convert" a ZIP archive to a ZIP archive in order to get rid of encryption (if you know the 
password) or to convert a self-extracting archive to a normal one.



Action:    “Make EXE...” Command

Selecting this command allows you to create a DOS, self-extracting archive from the current ARJ, 
ZIP or LZH archive.    The resulting archive will have an EXE extension and will self-extract itself 
under DOS on any computer; they do not need any other program to be extracted.



Action:    “Make WinSFX” Command

Selecting this command allows you to convert a ZIP archive to a Windows-based self-extracting 
archive.    These archives have an EXE extension and can extract themselves under Windows 
without using ZipShell Pro, PKUNZIP.EXE, or any other program.

WinSFX archives support ZIP 2.04 format files only; if you attempt to create a WinSFX archive from 
a file that contains ZIP 1.10 files, you will be asked to approve a conversion to ZIP 2.04 format 
before the WinSFX archive is created.



How-To For Common Procedures

Below is a list of common procedures you may wish to perform using ZipShell Pro.    Click on one for 
step-by-step instructions on how to perform it.

 Adding files to an archive
 Creating a new archive
 Deleting files from an archive
 Extracting files from an archive
 Opening and viewing an archive
 Using built-in compression and extraction
 Viewing files inside an archive



Deleting Files From an Archive

To delete files from an archive, you must first have opened it.    Then, select the files you wish to 
delete and press the Delete Button.    ZipShell Pro will ask you for confirmation and then will delete 
the files from the archive.

Be cautious when doing this, because files deleted in this manner from an archive are completely 
unrecoverable.

See Also:
Deleting an Archive
Opening and Viewing an Archive



File:    “Delete Archive” Command

Selecting the "Delete Archive" command from the "File" menu allows you to delete the current 
archive.    Confirmation is requested before this command is executed.



Extracting Files From an Archive

Before you can extract files from an archive (or perform any other operations on it), you must first 
open the archive to view its contents.

Then to extract files, you have two options.    One is to use the QuikExtract button, which will extract 
all the file(s) you have selected from the archive into the Target Path using default extraction options.
If no file(s) have been selected, ZipShell Pro extracts all the files from the archive.

The second option is to use the Extract button to be up the Extraction Options window.    This allows 
you to specify files you want to extract and gives you the opportunity to view and modify extraction 
options before proceeding. 

After you begin the extraction process, ZipShell Pro will extract the selected files and notify you of 
any errors that occur.

See Also:
Opening and Viewing an Archive
“Extraction Options” Window



“Extraction Options” Window

After you press the "Extract" button on ZipShell Pro's iconbar, the Extraction Option window is 
displayed.    This window contains two lists:    files that will be extracted, and those that will not.    You 
may move files between the two lists by using the "Move" and "Move All" buttons.    

After placing all the files in the appropriate lists depending on whether or not you want them 
extracted, you have two choices:    1)    you can accept the default options for extraction and press 
the "Extract" button to begin extraction immediately, or 2) you can press the "Next >>" button to 
display all of the options that you may use for extraction.

See Also:
Complete List of Extraction Options



Complete List of Extraction Options

Below is a list of all the extraction options available in ZipShell Pro.    Click on an option for a full 
description.    During extraction, only those options which are applicable for the type of archive being 
extracted will be enabled.

 Overwrite existing files
 Extract volume label
 Recreate stored paths
 Recover broken files
 Unscramble with password
 After extraction, create Program Manager items...
 Target path

See Also:
“Extraction Options” Window



If a file to be extracted already exists in the target directory, it will be deleted and the new file 
extracted in its place.    If this option is left unchecked, ZipShell Pro will ask you whether you want to 
overwrite files that already exist, if any.

Available for all archive types.



Extracts a volume label stored in the archive to the target drive.    If no volume label exists in archive,
this option has no effect.

Available for ZIP and ARJ archives.



Recreates any directories stored inside the archive during extraction.    If no directories exist in the 
archive, this option has no effect.    If there are directories in the archive, and this option is left 
unchecked, all files will be extracted to the target directory, regardless of the directories stored inside
the archive.

Available for ZIP archives.



Causes ARJ.EXE to search carefully through an archive in order to extract archives that have been 
corrupted.    When this option is checked, you will receive an error after the extraction process is 
complete.    This is normal and does not indicate a problem.

Available for ARJ archives.



ZipShell Pro will extract archives that contain encrypted files with a password that you supply.    If the 
archive contains no encrypted files, checking this option will have no effect.    If you supply an 
incorrect password, you will receive an error.

Selecting this option will cause ZipShell Pro to use PKUNZIP.EXE or ARJ.EXE to extract the file, 
instead of its own built-in extraction routines.

Available for ZIP and ARJ archives.



After extraction, ZipShell Pro will create a Program Manager group using the archive's name.    In this
group, it will create an icon for each program that it extracted, as well as each data file that has an 
association in the [Extensions] section of your WIN.INI file.

This option is also compatible with Norton Desktop for Windows and PC Tools for Windows.

Available for all archive types.



Specifies the directory where the archive will be extracted to.    You may scroll down to select from 
the last 3 or 4 directories used for extraction, or press the "Browse" button to browse for a new 
location.



Using Built-In Extraction and Compression

ZipShell Pro comes with built-in routines to compress and extract ZIP files and to extract ARJ files.    
Using these routines, ZipShell Pro is able to manipulate these files in Windows without shelling to 
DOS to use PKZIP, PKUNZIP, or ARJ.

Built-in ZIP extraction is compatible with all types of ZIP archives, but does not work with password 
encrypted files.    Built-in ZIP compression creates ZIP files which are 100% compatible with 
PKZIP/PKUNZIP 2.04; again, password encryption is not supported.    Archives created with built-in 
ZIP compression cannot be extracted with PKUNZIP 1.10; version 2.04 is required.

Built-in extraction and compression require a 386 or better processor.    To enable them, select the 
"Preferences" command from the "File" menu, go to the "Archivers" section, and check the boxes 
that say "Use built-in zipping and unzipping (or arj extraction) when possible."

If these built-in routines are enabled and ZipShell Pro encounters a situation where it cannot use 
them to manipulate an archive (such as extracting an archive with encryption), it will automatically 
revert to shelling to DOS to use PKZIP, PKUNZIP, or ARJ.



Viewing Files Inside an Archive

To view a file inside an archive, you must open the archive, select the file you wish to view, and then 
press the View button.    ZipShell Pro will then extract the file to a temporary location and launch a 
viewer to view it.    When you quit ZipShell Pro, these temporary files will be deleted.

The viewer which ZipShell Pro uses to view the file depends on the type of file to be viewed and the 
"Viewer Behavior" and "Default Viewer" options.    These options are accessible by choosing the 
"Preferences" command from the "File" menu and then selecting the "General" category.

See Also:
Opening and viewing an archive
“Viewer Behavior” option
”Default Viewer” option



Viewer Behavior

The option buttons in this section tell ZipShell Pro how you wish it to behave when you choose to 
view a file inside of an archive.

· Selecting the "Use Default Viewer" option will cause ZipShell Pro to always use the program you 
have specified in the "Default Viewer" section to view files.

· Selecting the "Use Associated File, If Any" option will cause ZipShell Pro to use whatever 
program is associated (in the [Extensions] section of the WIN.INI file) with the file you are trying 
to view.    If no program is associated with the type of file you are viewing, ZipShell Pro will use 
the program you have specified in the "Default Viewer" section.

· Selecting the "Prompt For Viewer To Use" option will cause ZipShell Pro to prompt you each time
you try to view a file whether you wish to use the default viewer or a program that is associated 
with the file you are trying to view.



Default Viewer

Specifies the program you wish to use as your default viewer.    This is the program that will be used 
most often to view files and should be a good text viewer or word processor.    See the "Viewer 
Behavior" section on information about when the default viewer is used.
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How to Contact NewVision Software

NewVision Software welcomes all comments, suggestions and questions you might have.    We may 
be contacted at any of the following:

Mailing address:
NewVision Software
101 N. Wacker Dr. Suite #CM153
Chicago, IL    60606

Phone:
(708) 383-2885

E-mail:
Internet:    newvision1@aol.com
CompuServe:    76020,732
America Online:    NewVision1

If you obtained ZipShell Pro from the World Intershare Network, questions about that organization 
should be directed to:

Wolrd Intershare Network
P.O.BOX 72069
Old Orchard P.O.
Burnaby, B.C. 
V5H 4P9

Fax: 1-800-510-2552
CompuServe: 102063,1230
Email: win@mindlink.bc.ca



Copyrights

ZipShell Pro and all accompanying files are Copyright © 1992-1995 by NewVision Software.    All 
rights reserved.

Portions of ZPSUNARJ.DLL are a modified version of UNARJ.EXE, Copyright © 1991-1993 by 
Robert K. Jung.    All rights reserved.

Portions of NVZIP.DLL are a modified version of InfoZIP's ZIP.EXE, Copyright © 1990-1993 by Mark 
Adler, Richard B. Wales, Jean-loup Gailly, Kai Uwe Rommel, Igor Mandrichenko and John Bush.    
Source code for ZIP.EXE available upon request for a $3.00 copying charge.



Software License

          ZipShell Pro is not public domain software, nor is it free.    Non-licensed users are granted a 30-
day period during which they may use ZipShell Pro on a trial basis, to see if it is suitable for their 
needs.    After the 30-day trial period, users are required to register the program or discontinue using 
it.

          Licensed users may use ZipShell Pro only on a single computer.    It may be used on more than 
one computer, as long as there is no chance of it being used on different computers at the same 
time.    Organizations interested in using ZipShell Pro on a number of computers or workstations 
should contact NewVision about the possibitility of obtaining a site license for the program.

          Licensed users of ZipShell Pro may not rent or lease the program, but may transfer the 
program, with all accompanying materials, on a permanent basis provided that they retain no copy of
the program, and the recipient agrees to all terms of the Software License.    ZipShell Pro is 
protected by copyright laws of the United States and must be treated like any other copyrighted 
material.    Under no circumstances may anyone disassemble, decompile, or reverse engineer the 
program.



Supported Archivers

In order to perform some of its functions, ZipShell Pro requires the presence of third-party, DOS-
based archivers.    These archivers may be present anywhere on your system (ZipShell Pro will 
prompt you for their location the first time they are used).    You only need archivers appropriate for 
the type(s) of archives you wish to use.    Also, ZipShell Pro is able to extract most ZIP and ARJ files 
internally, and compress ZIP archives internally, without using an external program.    The supported 
archivers are as follows:

1 For ZIP files: PKZIP.EXE & PKUNZIP.EXE, any version
by PKWARE, Inc.

2 For ARJ files: ARJ.EXE, version 2.30 or later
by Robert Jung

3 For LZH files: LHA.EXE, version 2.1x
by Haruyasu Yoshizaki

4 for ARC files: ARC.EXE, version 6.02 or later
by System Enhancements Associates, Inc.



Warranty Disclaimer

          THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING 
INSTRUCTIONS FOR USE) ARE PROVIDES "AS IS" WITHOUT WARRANTY OF ANY KIND. 
FURTHER, NEWVISION DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF THE SOFTWARE 
OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, RELIABILITY, 
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND 
PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE SOFTWARE OR WRITTEN 
MATERIALS ARE DEFECTIVE, YOU, AND NOT NEWVISION OR ITS DEALERS, DISTRIBUTORS, 
AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, 
REPAIR, OR CORRECTION.

          NEWVISION DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER 
EXPRESS OR IMPLIED, INCLUDING BUT    NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.    NEITHER NEWVISION 
NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR 
DISTRIBUTION OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, 
CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO 
USE THIS SOFTWARE EVEN IF NEWVISION HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES OR CLAIMS.    IN NO EVENT SHALL NEWVISION'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, 
REGARDLESS OF THE FORM OF CLAIM.    THE PERSON USING THIS SOFTWARE BEARS ALL 
RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.    YOU MAY HAVE 
OTHER RIGHTS WHICH VARY FROM STATE TO STATE.

          This agreement shall be governed by the laws of the State of Washington.    Any action or 
proceeding brought by either party against the other arising out of or related to this agreement shall 
be brought only in a STATE or FEDERAL court of competent jurisdiction located in King County, 
Washington.



What's New

Below are some of the new features of ZipShell Pro 4.0:

· Completely redesigned interface with more intuitive and attractive dialogs.
· Removed command buttons and replaced with more functional toolbar.
· Added "recurse subdirectories" option when compressing ZIP archives.
· Added option to create a Program Manager group and icons for items extracted.    Compatible 

with Norton Desktop and PC Tools.
· Entire directories can be drag-and-dropped onto ZipShell Pro for compression, instead of just 

files as with the previous version.
· Main listbox now resizes properly when its parent window is resized.
· Fixed bug that caused PKZIP to crash when the -& and -b options were both selected.
· Added "QuikExtract" button for quick extraction with no dialogs to sort through.
· Added support for advanced PKZIP and PKUNZIP v2.04 memory options.
· When deleting files from an archive, replaced the confirmation message box with a confirmation 

dialog, to prevent the creation of a message box larger than the screen when a large number of 
files are selected.

Here are the new features that have been added to ZipShell Pro 4.1:

· ZipShell Pro now performs built-in zipping and unzipping operations in the background, allowing 
you to use other programs while ZipShell is busy.

· If a copy of ZipShell Pro is already running when you attempt to launch an archive in the File 
Manager, the current copy of ZipShell will open the archive in a new archive window.    A second 
copy of ZipShell Pro will not be launched.

· The "Browse Directories" dialog has been redesigned to conform to Windows common dialogs 
specifications.    The new dialog is more intuitive and should be easier to use.

· The "New" button on the toolbar has been re-implemented.    Now, pressing this button will cause
ZipShell Pro to begin the process of creating a new archive, instead of simply creating a new, 
empty archive window.

· ARJ files can now be extracted using the path information stored in them.
· When executable files are "viewed", they are now extracted and launched.    Previously, they 

were opened up with notepad.
· The "Rename" command has been replaced with a "Save As" command.
· ZipShell Pro now correctly reads ZIP archives which contain extra bytes at the beginning of the 

file.
· Previous versions of ZipShell contained a bug where complex ZIP archives with identical files in 

different directories were not extracted correctly.    This has been fixed in this version.
· If the Target Path is set to a non-existent directory, ZipShell Pro will now create the directory 

before attempting to extract the archive.
· A bug in which the columns in the main ZipShell display would sometimes lose their alignment 

has been fixed.



A Beginner's Guide to Archives

This file is designed to acquaint new users with the concept of archive usage:    what archives are, 
how and when to use them, and popular archive types..    Also included is a brief discussion of how 
archives work.

 Archive?    What's that?
 When should I use an archive?
 Types of archives
 What do I need to work with archives?
 How do archives work?



What is an archive?

In the early 1980's, when someone wanted to send some computer files (a program and its 
accompanying documentation files, for example) to someone else over a modem there was no better
way to do it than send them one by one, an inconvenient and time-consuming process.    Copying 
programs onto floppy diskettes to give to friends or associates also was made difficult by the fact that
most floppy drives at the time were of the 360K variety, so a large number of diskettes would 
sometimes be required, and if you had a single file larger than 360K, it would not fit on a floppy disk 
and you were pretty much out of luck.

To cope with these problems and the increasing popularity of BBS's and Shareware that occurred 
later in the decade, the archive was developed.    An archive is just a particular type of computer file 
that serves a particular purpose; in this case, to store a number of files together inside one file, while 
at the same time compressing them so that they take less space.    This has two desirable effects 
when sending files over a modem:    a group of files can be sent at once, and the total transmission 
time is reduced, sometimes dramatically.

Over the years, archives have developed into several varieties, but all have the same basic function: 
they can store a large number of files inside a single file (much the way large numbers of news 
articles can be 'stored' inside a single newspapers), and the resulting conglomeration is compressed 
(or shrunk) so that the file takes up less storage space on a hard or floppy disk than it otherwise 
would.



When should I use an archive?

Archives are typically used in the two situations described below:

· When files are sent or received over a modem, they are almost always archived.    This saves 
substantially on transmission time and enables groups of files to be sent together.    Nearly all 
files downloaded from a BBS or online service will be archived in some way.    If you plan to 
upload files to one of these services, you should archive them, first checking which archive type 
is most commonly used on the system.

· When files are copied to floppy diskettes they are often archived also.    This enables more files 
to fit on one diskette than would otherwise be possible, thus reducing the total number of 
diskettes needed to copy a given number of files.

Caution:      It is important to remember when sharing archives with other users that the person you 
are sharing your archive with must have a tool to extract the information from the archive, or else the 
archive will be useless.    For this reason, it is wise to use one of the industry-standard formats 
described in the next section.    This will increase the likelihood of the other user being able to use 
your archive.    In cases where you cannot be sure what archiving tools the other user will have, you 
may elect to use a self-extracting archive, also described in the next section.



Types of Archives

There are several different varieties of archives in use on DOS computers.    Each type requires a 
different program to manipulate, but all are similar in form and function.    The term "archive" is used 
to denote a computer file which contains other compressed files, while the term "archiver" is used to 
reference the program that is required to manipulate a particular type of archive.

The four most popular archives types in use today are ARC, ARJ, LZH and ZIP, all of which can be 
manipulated using NewVision's ZipShell Pro.    More obscure archive types include PAK, ZOO, and 
ICE.    Following is a brief discussion of each of the the four major types:

1 ARC:    This is the earliest general-pupose archiver produced for the PC.    After its release in 
1985 by System Enhancement Associates, it quickly became the standard for DOS users 
worldwide.    Although still in occasional use today, it has been relegated to relative obscurity by 
the three remaining types described below, all of which offer better speed, tighter compression 
ratios, and/or more features.    Many older files on BBS's are archived in this format, so it is 
handy to have a program which can manipulate it, of which there are many.

2 ZIP:    Released a few years after ARC, the programs PKZIP (used to create ZIP archives) and 
PKUNZIP (used to extract them) by PKWARE, Inc., quickly replaced ARC as the dominant 
archive type.    It's main advantage over ARC is speed, but it also boasts high compression ratios
and a richer feature set.

3 LZH:    Although not as popular as ZIP archives, LZH archives are often used today in place of 
ZIP files, mainly because its creator (Haruyasu Yoshizaki) has distributed his archiver (LHA) as 
freeware, allowing any person or organization to use it free of charge.    The source code to this 
utility is freely available, so this archive type has been ported to many other operating systems.

4 ARJ:    Relatively new on the scene, ARJ impressed its users with its tight compression ratios and
its inclusion of many advanced features, such as the ability to split a large archive up onto 
several floppy disks.    Recent versions of PKZIP have addressed this issue, but ARJ continues to
enjoy a modest following.    Its creator (Robert Jung) has also made availble the source code to 
extract ARJ files.

Self-Extracting Archives

Not a unique type itself, the self-extracting archive is a derivative of one of the types listed above.    It
is an option that allows the archive to be created as an executable program which can extract itself 
on any computer without using an archiver or other tool.    Thus, its main advantage is that everyone 
can use it, whether or not they have any archiving programs on their system.

Creating self-extracting archives usually costs both space (the resulting archives can be as much as 
30K larger than their non-self-extracting counterparts) and money, since most companies require a 
distribution license to allow users to distribute self-extracting archives created by their archivers.    
Exceptions to this are LHA, which is completely free (as noted above), and NewVision's ZipShell 
Pro, which creates Windows self-extracting archives (executable archives that extract themselves 
under the Windows environment) that may be distributed without a distribution license.



What do I need to work with archives?

In order to create and extract archives of a given type, you need a program (or archiver) which is 
capable of manipulating that archive type.    Given below are the most popular DOS programs for 
doing so.    Note that these have no user-interface per se, but are driven by complicated command-
line arguments.

· For ZIP archives:    PKZIP.EXE and PKUNZIP.EXE by PKWARE, Inc.    Latest version:    2.04g.
· For LZH archives:    LHA.EXE by Haruyasu Yoshizaki.    Latest version:    2.12.
· ARJ.EXE by Robert Jung.    Latest version:    2.40.
· For ARC archives:    ARC.EXE by System Enhancement Associates.    Latest version:    6.02.    

Also commonly used is PKARC by PKWARE, Inc.

Hint:    For many users, an attractive altnerative to learning the command-line syntaxes of the above 
archivers is to use an archive shell, which handles a lot of the drudge work automatically and lets you
treat archives of different types exactly the same.    You still may need the above programs, but you 
will no longer have to use them directly.    Rather, the archive shell will invoke them as needed.    
NewVision's ZipShell Pro is such as archive shell, which has the additional benefit of using its own 
internal routines when working with ZIP archives, so that it rarely (or never) needs the services of 
PKZIP.EXE and PKUNZIP.EXE.



How do archives work?

Following is a brief discussion of how archiver compression works.    You do NOT need to 
understand this in order to use archives well, so if you're not interested, feel free to skip this section.

There is a lot of repetition in most computer files, and archivers are able to compress them by 
exploiting this fact.    For example, suppose a word processing document contains 50 occurrences of 
the word "the."    Instead of storing this word 50 times, why not store it just once?    The first time the 
archiver runs across the word "the", it stores it as is.    The next 49 times it just inserts a pointer to the
original phrase, thus saving space.    It's actually a little bit more complicated than this, but this is the 
basic picture, and this is the sort of compression used by almost every major archiver.    These 
compression algorithms can restore the original data exactly, and thus are called "lossless" 
algorithms.

Although not an archive, many graphics formats utilize compression techniques that differ somewhat
from the one explained above.    In particular, JPEG files achieve remarkable compression of 
graphics files through a "lossy" technique:    some of the original data in the picture is lost, but usually
not enough to degrade the picture to any great degree.    The amount of compression can be varied, 
which results in a gain or loss of picture resolution.

Common Compression Acronyms:
· CRC:    Cyclical Redundancy Check.    An algorithm used by archivers to ensure data integrity.
· LZW:    Type of lossless compression named for its creators:    Jacob Ziv, Abraham Lempel, and 

Terry Welch.
· GIF:    Graphics Interchange Format.    A graphics format, originated by CompuServe, which uses 

LZW compression to reduce image size.
· JPG:    DOS extension for graphics files compressed with    the JPEG algorithm.    JPEG is an 

acronym for Joint Photographic Experts Group.
· RLE:    Run-Length Encoding.    A type of compression whereby a stream of identical characters 

is stored as a single character plus a count.
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“Archive Comment Editor” Window

An archive comment is a message which can be attached to any ZIP or ARJ archive.    When using 
ZipShell Pro, this message can be viewed by clicking on the "Comment" button on ZipShell's main 
display.    When using PKUNZIP to unzip the file, the archive comment will be displayed on the 
screen prior to extraction.

The archive comment for the current archive, if any, is displayed in this window.    You can use the 
toolbar to turn word-wrap on or off to make viewing easier.

When you press the "Close" button to close the window, ZipShell Pro will check to see if you have 
modified the archive comment.    If you have, you will be asked whether you want to save the 
modifed comment back into the archive.    If you reply "yes", ZipShell Pro will write the new comment 
into the current archive; otherwise, any changes to the comment will be discarded.



Enter Password

The archive that you are attempting to extract contains files that have been encrypted, or scrambled,
to protect its data from being accessed by unauthorized persons.    Such files require a password in 
order to be extracted successfully.

To continue the extraction, enter the password in the space provided and press the "OK" button.

NOTE:    ZipShell Pro's built-in unzipping routines do not work with encrypted files.    When you 
continue the extraction by pressing the "OK" button, ZipShell Pro will utilize PKUNZIP.EXE to extract 
the archive.



Associate

Clicking on this button causes ZipShell Pro to associate itself in the [Extensions] section of the 
WIN.INI file with all ZIP, ARJ, ARC and LZH archives.    This means that whenever you attempt to 
launch one of these archives, ZipShell Pro will be launched and the archive will be opened up for 
viewing.

ZipShell Pro automatically associated these archives with itself the first time it is run on your system. 
If you have moved ZipShell Pro since then, or have had another program modify these associations, 
clicking the "Associate" button will return the associations to their previous state.



Exploding Windows

If this option is checked, ZipShell Pro will use a visual effect called "exploding" when displaying most 
of its windows.    If you find this effect unappealing, or if you find that it takes too long due to a slow 
video card, disable this option.



Show File Open Dialog On Startup

If this option is checked, ZipShell Pro will display the Open Archive window everytime it is started, 
allowing you to choose an archive to open.    However, if ZipShell Pro has been started with a 
filename as a parameter, the Open Archive window is not displayed, even if this option is checked.



Archivers

Use this window to set global compression and extraction options.

· PKZIP and PKUNZIP version:    Select the version of PKZIP and PKUNZIP you wish to use.    It is
suggested that you use version 2.04 for it offers better compression ratios, is faster, and is 
compatible with all of ZipShell Pro's built-in archiving routines.

· Check the "Use built-in zipping and unzipping" and "Use built-in arj extraction" boxes if you wish 
to make use of ZipShell Pro's built-in archiving routines.    These routines are internal and 
Windows-based, enabling most commong procedures to be done without shelling to DOS.

· The "Advanced Options for PKZIP & PKUNZIP" display some global memory options available 
when using PKZIP and PKUNZIP 2.04.    If you get strange errors (such as a "violated system 
integrity" error) when ZipShell Pro shells to PKZIP or PKUNZIP v2.04, disabling all the options 
except "Use Slow Memcopy" may help.



Display Options

Use the commands in this window to alter the appearance of ZipShell Pro's main list display.

· Use the "Font" button to change the font displayed in ZipShell Pro's main listbox.    Only fixed-
pitch fonts are available for selection.

· Use the "Color" button to change the color used as background in ZipShell Pro's main listbox.



General Options

Select one of the options below for a full description:

 Show File Open Dialog On Startup
 Exploding Windows
 Viewer Behavior
 Default Viewer
 Associate



Paths

Use the Paths window to edit the locations of the DOS-based archivers that ZipShell Pro may need 
to use.    To browse for a location, select an archiver and then press the "Browse..." button.

It is not necessary to enter the correct location of an archiver before using it for the first time.    If 
ZipShell Pro requires the use of a DOS-based archiver and cannot find it, it will prompt you for its 
location at the time it is needed.



Add Button
Pressing this window displays the "Add Files to Archive" window, allowing you to add files to the 
current archive.    If there is no archive open in the current window when this button is pressed, 
ZipShell Pro will assume you wish to create a new archive and will ask you for the new file's name 
and location before allowing you to proceed with the selection of files to be added.

See Also:
Adding files to an archive



Comment Button
Pressing this button displays the archive comment, if any, and allows you to edit it if you wish.    This 
button is disabled for LZH and ARC archives.

See Also:
“Archive Comment Editor” window



Delete Button
Pressing this button will allow you to delete the selected files from the current archive.    Confirmation
is asked before the process is completed.

See Also:
Deleting files from an archive
Deleting an archive



Extract Button
Pressing this button displays the "Extraction Options" window, which allows you to specify files for 
extraction and view and/or modify extraction options before proceeding with decompression.

See Also:
Extracting files from an archive
“Extraction Options” window



New Button
Allows you to create a new archive.    Has the same effect as selecting the "New Archive" command 
from the "File" menu.

See Also:
File:    “New Archive” Command



Open Button
Displays the Open Archive dialog and displays the selected file in the current archive window.    
Pressing this button has the same effect as choosing the "Open/Current Window..." button from the 
"File" menu.

See Also:
File:    “Open/Current Window...” command



QuikExtract Button
Pressing this button extracts the selected files to the Target Path displayed at the bottom of the 
archive window.    Default extraction options are used; the Extraction Options window is not 
displayed.    If you wish to view and/or modify the extraction options, use the Extract button instead.

If no files are selected when this button is pressed, all the files in the archive are selected and 
extracted.

See Also:
Extracting files from an archive



View Button
Pressing this button will cause ZipShell Pro to extract the currently selected file and display it for 
viewing.    The file is extracted to a temporary location and is deleted when ZipShell Pro is closed.

The choice of the viewer which ZipShell Pro uses to view the file is determined by the "Viewer 
Behavior" and "Default Viewer" sections under the General Options window.

See Also:
Viewing files in an archive



BBS's
Acronym for Bulletin Board Service.    A BBS is a computer service that home computers can connect to 
electronically, via a modem.    Many offer features such as file transfers, message boards and chatting 
with other users.



modem
Acronym for MOdulator-DEModulator.    A modem is a device used by computers to send data over 
normal telephone lines.    They are usually used by home computers to connect to BBS's and online 
services, such as CompuServe and America Online.



Shareware
Shareware is a method of software distribution.    It allows users to try software for a period of time 
before they decide whether they would like to purchase it.    Thus, users can find the software that is right
for them without paying large amounts of money for programs which they may find they don't like.    
Shareware programs are also often less expensive than their commercial counterparts, and yet often 
achieve equal or superior functionality.    Although copyrighted, shareware programs may be freely 
distributed.    This benefits both the author of the program, who would like as many users to try the 
program as possible, and the users, who have a huge number of high-quality programs to try before they
buy.



Target Path
The path that files will be extracted to during a decompression operation.    This location is specified in 
the status line at the bottom of the archive window.    Clicking on this path with the mouse (or pressing 
[ALT + P]) will allow you to change the Target Path.






